
 

 

Tvorba vlastní vystřihovánky 
Návod na tvorbu modelů z papíru 

 

Petr Kašpar 
 

Při tvorbě vystřihovánek se budeme držet 

zavedených zvyklostí, které pro Českou 

republiku nastolil převážně ing. arch. 

Richard Vyškovský. Tento autor publi-

koval své papírové modely hlavně  

v časopise ABC a každý kdo se zajímá   

o vystřihovánky se s jeho prací pravdě-

podobně setkal. Proto i my budeme 

dodržovat stejné značení a postupy. 
 

Jedná se hlavně o značení ohybů, 

číslování dílců a celkovou strukturu 

návodu. 

ing. arch. Richard Vyškovský 

 

Veškeré práce budeme provádět v programech, které jsou zdarma dostupné, nebo 

přístupné na školních počítačích. 

 

Jedná se o programy: 

Google SketchUp:  

Download: http://sketchup.google.com/intl/en/download/ 

Google LayOut: 

Program je součástí Google SketchUp Pro a je v časově omezené trial verzi zdarma. 

 

A k úplnému dokončení použijeme program na tvorbu PDF souborů. Já používám 

program Scribus, ale vy můžete použít jakýkoliv program, se kterým máte zkušenosti. 

 

Tyto programy jsem volil pro jejich snadné ovládání, vhodnost k tvorbě jednoduchých 

modelů (které pro papírové modely plně dostačují, neboť drobnější detaily papír 

nesnese) a snadno se obohatí o pluginy, které nám práci usnadní. Navíc jsou s nimi 

studenti seznámeni v rámci kurzů CAD, nebude nás tedy zdržovat neznalost tvorby 

3D modelu. 

Vystřihovánky lze tvořit také bez použití 3D modelu, stačí mít dostatečně podrobné 

zobrazení v MP: pohledy a řezy (stavební výkresy jsou vlastně tímto požadovaným 

zobrazením).

http://sketchup.google.com/intl/en/download/


 

 

Celou tvorbou vám předvedu na mém modelu rozhledny Štěpánka, která                     

je považována za nejhezčí rozhlednu Jizerských hor. Na každou budovu je třeba zvolit 

vlastní postup, proto se návod nedá psát obecně. Nejprve vysvětlím práci na svém 

modelu a na závěr předvedu příklad řešení běžných detailů, jako dveře, okna, 

zakřivené plochy, kopule, vikýře, komíny a jehlanovité špičky věží. Celý návod         

si nejprve přečtěte a teprve poté začněte s prací na vlastním modelu. 

 

1. krok - Výběr stavby 

Jako model je nejvhodnější zvolit stavbu, ke které máme možnost snadno sehnat pod-

klady. Ať už výkresy na stavebním úřadě, nebo ruční zaměření. Proto volíme buď 

známé zahraniční či české stavby, nebo stavby, ke kterým můžeme zajít, nafotit je 

a změřit jejich rozměry. 

Já volil Štěpánku proto, že k ní mohu během jednoho dne dojít a je to jedna z ikon 

Jizerských hor. 

 

Jak můžete vidět z přiloženého obrázku, u starých staveb se nevyplatí spoléhat na 

údaje z podkladů dostupných na stavebním úřadě, často jsou nekompletní, neodpoví-

dají realitě, v pohraničí jsou dokonce německy. 

 

2. krok - 3D model  

Nyní vytvoříme 3D model v programu Google SketchUp. Než 

začneme, musíme si ujasnit v jakém měřítku bude 

vystřihovánka provedena. Je to na vašem osobním rozhodnutí, 

ale doporučuji volit některé ze standardních měřítek a to 

pokud možno tak, aby výsledný model nepřesáhl rozměry 

30×30×30 cm. U staveb, jejichž jeden rozměr je výrazně větší 

než rozměry ostatní, lze toto pravidlo pochopitelně porušit, ale 

je nutno pamatovat na to, že velmi velké hotové vys-

třihovánky většinou nepůsobí příliš pěkně. Vše ovšem záleží 

především na konkrétní stavbě a návrhu modelu. Podle toho 

určíme míru detailů 3D modelu. Nejmenší možné detaily na 

papírovém modelu jsou 2 mm. Menší dílky by už  modeláři 

nebyli schopni uspokojivě zvládnout (mějte na pamněti, že 

velká část modelářů jsou děti). 

 

Na internetu je možné stáhnout mnoho hotových 3D modelů staveb. Důrazně vás však 

před tímto řešením varuji. Modely nejsou tvořené s ohledem na následnou tvorbu 

papírové vystřihovánky a jejich upravení je zpravidla pracnější než tvorba vlastního 

modelu.

http://cs.wikipedia.org/wiki/Štěpánka_(rozhledna)


 

 

Při tvorbě 3D modelu máme na paměti několik pravidel. Model budeme rozkládat do 

roviny, proto modelujeme pouze to, co bude součástí výsledného papírového modelu. 

Vyvarujeme se tedy přesahů, prolínání jednotlivých částí a dalších postupů běžně 

používaných v 3DsMaxu a podobných programech. Také vůbec nepoužíváme skryté 

hrany, mohli bychom na ně zapomenout a vadily by nám jak při texturování, tak při 

rozkládání modelu do roviny. Veškeré hrany nechte viditelné, po rozvinutí půjdou bez 

problémů odstranit.  

Je nutné si uvědomit, že některé tvary ani nejsme schopni z papíru vytvořit. Musíme 

proto už při tvorbě 3D modelu na podobné situace myslet a model podle nich zjedno-

dušit. SketchUp má pro nás tu výhodu, že veškerou geometrii skládá z částí rovin, 

dokonce i koule je jen větší množství rovinných plošek.  

 

Obrázek ilustruje tvorbu 3D modelu. Na prvním obrázku je detail vstupu do rozhled-

ny, na druhém obrázku je ten samý detail zobrazený zespoda zezadu. Červeně jsem 

obtáhnul chybu, malé plošky přesahující za viditelný plášť stavby. Na papírovém mo-

delu nebudou a jen by nám komplikovaly rozvinutí modelu do roviny. Na podobné 

věci pozor! Zelenou barvou jsem obtáhl plochu, která bude tvořena jedním dílem, 

hrana vznikne pouze ohybem dílu, nikoliv slepením dvou částí. Přestože to není plo-

cha na plášti budovy, její odstranění by modelářům velice znesnadnilo práci 

a papírový model by byl méně stabilní. Žlutou barvou je obtažen podpůrný pilíř, který 

bude z několika dílů zkompletován zvlášť a poté bude nalepen na konstrukci rozhled-

ny. 

Podobně musíte uvažovat u vašeho modelu, neexistuje přesný návod na postup. Proto 

je tato práce tak zajímavá a tak těžká. Velice vám však pomůže zkušenost s lepením 

papírových modelů. Doporučuji několik modelů sestavit předtím, než se pustíte        

do tvorby vlastního. 

 

Nyní je také správný čas na úvahu o tom, jak zpracovat terén, okolí modelu. Pokud 

bude součástí papírové vystřihovánky, vymodelujte ho společně s vlastní stavbou.       

U některých staveb lze vynechat. 

 

Pokud má váš model velké prázdné prostory uvnitř, doporučuji vymodelovat podpůr-

ná žebra, které papírovou konstrukci ponesou, i když se na jejím vnějším vzhledu ne-

budou podílet. To je velice časté při modelování terénu. Viz obrázek základního teré-

nu a pohled zespod na žebro, které zamezí prohýbání papíru: 

 

 



 

 

3. krok – Textury 

Výjimečně lze mít model i bez textur, ale není to běžné. Pokud máte možnost budovu 

nafotit, je nejjednodušší použít fotografie a nanést je na model jako textury, což nám 

SketchUp umožní opravdu snadno. 

Vyberte zvolený povrch modelu (1) a v okně Materials (Window => Materials) pře-

jděte pod záložku edit (2) a zaškrtněte volbu Use texture image (3): 

 

 
 

Textura je nyní na modelu, ale pravděpodobně nebude zobrazena správně.                

To opravíme následovně: Klikněte pravým myšítkem na vybraný povrch, z vyvolané 

nabídky zvolte Texture => Position a pohybem 4 připínáčků na rozích textury ji za-

rovnejte: 

 

 
 

Pokud nemáte možnost pořídit fotografie stavby, můžete použít textury, které obsahu-

je přímo SketchUp, nebo nalézt vhodné textury na internetu.  

Další možností je namalovat díly ručně, výsledek bude při pečlivé práci často lepší 

než fototextury. V případě ruční kresby kapitolu 3 přeskočte a díly dokončete až po 

vytisknutí vystřihovánky. 



 

 

4. krok - Rozvinutí modelu do plochy, tvorba dílů  

3D model máme hotový, nyní ho rozvineme do roviny a vyrobíme z něj jednotlivé 

dílce vystřihovánky. Nejprve SketchUp rozšíříme o plugin Unfold tool, který nám 

práci výrazně usnadní.  

Stáhněte ho z adresy: 

http://sketchup.wu.cz/data/pluginy/unfoldtool.zip, rozbalte a nakopírujte do adresáře 

"plugins", implicitně "c:/programfiles/google/sketchup/plugins" a restartujte program. 

Nyní se vám pod záložkou Tools zobrazí nástroj Unfold.  

Používá se následovně: Po kliknutí na unfold vybereme plochu, která slouží jako 

začátek rozkládání modelu do plochy. Poté klikneme na sousední plochu a nástroj 

unfold k ní zarovná předchozí výběr.   

Postup práce lépe popíše následující obrázek: Z hotového modelu překopírujte 

vybranou část (1), v mém případě střechu rozhledny. Vybranou část rozdělte prostým 

výběrem a kopírováním na části podle dílů (2). Následně díly rozložte pomocí 

nástroje Unfold (3). Rozložený díl otočte do vodorovné polohy (4). Původní model 

zachovejte nedotčený, bude potřeba k tvorbě návodného obrázku. 

 

 

Vytvořené díly ještě musíme opatřit chlopněmi, aby je bylo možné slepit. To je 

vhodné udělat u každého dílce rovnou po rozložení, já to však kvůli přehlednosti 

návodu popisuji v náledující kapitole. 

http://sketchup.wu.cz/data/pluginy/unfoldtool.zip


 

 

5. krok - Chlopně 

Díly máme hotové, ale ještě je musíme opatřit chlopněmi, aby je bylo možné přilepit 

k dalším dílům. Každá hrana dílu musí mít chlopeň, nebo musí být chlopeň na hraně 

dílu který bude na díl navazovat. Šírka chlopní je volitelná, doporučuji vybrat                 

ji z rozmezí 2–7 mm podle velikosti dílu který chlopně obsahuje. Menší rozměry jsou 

na hranici zvládnutí pro modeláře, větší rozměry už spíše ohrožují vzhled modelu, 

neboť čím více lepidla bude na chlopeň použito, tím vyšší je riziko krabatění papíru. 

Chtěnou velikost na papíře přepočítáme podle zvoleného měřítka a vymodelujeme          

ve SketchUpu. Také musíme zkontrolovat je-li na chlopeň místo na dílu kam budou 

modeláři chlopně lepit. Ohyb či otvor blízko kraje dílu mohou nalepení chlopně 

bránit. Tomu se musíme vždy přizpůsobit a chlopeň podle toho upravit. I vlastní díl 

může po naohýbání chlopně vadit. Úhel skosení hran chlopní je běžně 45 nebo 

menší. 

 

Pro lepší pochopení opět uvádím obrázky ilustrující výše popsané: Všechny díly stře-

chy jsou nyní v rovině a opatřeny chlopněmi. Všimněte si: Chlopeň u vrcholu jehlanu 

je skosená pod úhlem 18, aby se vešla na plochu, která je jí umožněna ohybem dílu 

(1). Maličké chlopně spojující hrany, které jsou na dílu blízko u sebe, nejsou vyne-

chány. Přestože půjdou velice špatně lepit, zakryjí alespoň otvory do modelu 

a s trochou lepidla budou dokonce funkční (2). Otvor do spodního dílu střechy by 

nebyl nutný, ale ponechaná plocha je dostatečná na nalepení chlopní a přístup prstů 

k zadní straně dílů modelářům velice usnadní práci. Proto se o to snažte vždy, když je 

to možné a neohrozí to pevnost modelu (3).



 

 

I na přidávání chlopní existují pluginy, zde však doporučuji ruční postup. Ještě jsem 

nenarazil na plugin který by toto zvládal bezchybně, hlavně u složitějších dílů. Práci 

nám dostatečně usnadní sám SketchUp. Kopírování, posun a rotace budou našimi 

hlavními nástroji. Od této chvíle přepneme pohled na TOP a v pracovním prostoru se 

budeme pohybovat pomocí Shift+mmb (middle mouse button, prostřední tlačítko my-

ši), tím vlastně eliminujeme třetí rozměr, který by nám nyní pouze překážel. 

 

6. krok - Ošetření hran chlopní, usnadnění práce modelářům 

Jak vidíte na výše uvedeném obrázku, každá chlopeň má na hraně kterou přiléhá               

k dílu proužek barvy která nejvíce odpovídá textuře dílu.  

To se provede snadno:  

Chlopeň (1) rozdělte další čarou (2), vzniklou plochu otexturujte  zvolenou barvou (3) 

a přidanou čáru skryjte pomocí volby Hide (4). 

 

Pro urychlení používejte klávesové zkratky, zde: E (pro vybrání nástroje Erase)             

a Shift + lmb (left mouse button, levé tlačítko myši) klikněte na vybranou čáru. Pokud 

jste omylem skryli něco jiného: View => hidden geometry => rmb na vybranou čáru 

=> unhide. 

Toto přestává být u vystřihovánek běžné, smysl to však má. Nepřesnosti při lepení 

jsou díky tomu daleko méně vidět a model vypadá skvěle i bez dodatečného 

zabarvování bílých míst nepřesností. A o to nám jde nejvíce, nesnažíme se o co nej-

méně práce při tvorbě modelu, ale o co nejhezčí výsledný model. 

 

7. krok - Uspořádání dílů k tisku 

Nyní mame všechny díly v jedné rovině. Připravíme si obdélníky o velikosti papíru na 

který budeme vystřihovánku tisknout. Tzn. rozměry papíru vynásobené měřítkem 

modelu. Na takto připravené „listy papíru“ poskládáme jednotlivé díly tak, aby 

zabraly co nejméně listů. 



 

 

 

Pokud má nějaký díl část, která bude vystřižena, můžete klidně díly umístit i do ní. 

Běžně se to používá k ušetření místa. 

 

 

8. krok - Číslování 

Každému dílu přiřadíme jeho číslo, aby se na něj dalo v návodu odkazovat. Číslujeme 

přesně tak, jak budou modeláři postupovat při lepení modelu. Musíme si tedy v hlavě 

rozvrhnout postup lepení modelu a podle něj díly očíslovat. Já kupříkladu začínám 

střechou a číslování postupuje, stejně jako práce na modelu, odshora dolů. Nejprve 

střecha, poté cihlová část rozhledny a nakonec kamenná část s pilíři. To je vhodné        

i proto, že zatímco lepidlo na jedné čáti modelu schne, může modelář pracovat na 

další části. I to by mělo být vzato v potaz. 



 

 

 

9. krok - Pomocné značení 

Abychom ulehčili práci modelářům, používáme ještě několik značek, které jim při 

práci na modelu napoví jak jednotlivé díly složit. Na každou chlopeň uvedeme číslo 

dílu, na který bude nalepena. Pokud je chlopeň určena k nalepení na „vlastní“ díl (tj. 

na stejný díl, na kterém je umístěna), uvádí se značka „%“.  

Další značky slouží k tomu, aby modeláři poznali jestli je ohyb dílu konvexní, nebo 

konkávní. Konvexní ohyb se označuje kuličkou, konkávní trojúhelníčkem. Od značek 

se vede linie ke hraně ohybu. 

Jako poslední značka se používá ikonka nůžek, k označení místa které má být 

rozstřihlé i když na dílu není dost místa k vynechání prostoru. Názornější bude opět 

obrázek ilustrující popsané značky: 

Čísla na chlopních určitě smysl mají, znak nůžek také, ale naznačení směru ohybu lze 

dle mého názoru vynechat. Díly se stejně ohýbají až po vystřižení a tím značení ztrácí 

smysl. Snad nikdy jsem ještě nebyl nucen dohledávat odstříhlé části jen kvůli zjištění 

směru ohybu. Dle mého je to zbytečná věc, kterou uvádím jen pro komplexnost.        

U komplikovaných dílů bych dal přednost upozornění v návodu a u lehkých dílů 

značení není nutné a jen znepřehledňuje vystřihovánku. Konečné rozhodnutí              

je samozřejmě na vás. 



 

 

10. krok - Příprava na tisk, tisk do PDF 
Vystřihovánka je prakticky hotová. Stačí ji pouze vytisknout. To provedeme pomocí 

programu Google LayOut. Ve SketchUpu odstraňte pomocné rámečky ohraničující 

listy papíru. Následující postup lépe pochopíte díky přiloženým obrázkům. Otevřete 

program LayOut, a nastavte formát papíru, já používám A3 které následně ohnu 

napůl. Hotová vystřihovánka tak bude na formátu A4. Případně lze použít pro výstup 

přímo formát A3. 

 

 
 

 

Menu File => insert a vyberte váš SketchUp model. 

 

 



 

 

 

Modře ohraničený obdélník roztáhněte za hranice papíru.  

 

 
 

 

V pravém menu sjeďte k záložce SketchUp model. V ní kliknte na tlačítko Ortho, 

nastavte pohled na Top a vyberte vaše měřítko. V pravém dolním rohu máte na výběr 

ze tří možností tisku: Vector vyberte pokud nemáte na dílech textury, druhá možnost 

není pro nás a Hybrid zvolte v případě otexturovaných dílů. Modrý obdélník, který 

jsme v minulém kroku rozšířili až za hranice papíru slouží jako "okno" do vašeho 

modelu ve SketchUpu. Nyní už skrz okno vidíte část modelu ve zvoleném měřítku. 

Klikněte do prostoru modrého okna a pomocí Shift + Lmb přesuňte model tak, aby 

byla v okně část, která patří na tuto stránku. 

 

   



 

 

 

Export je v nabídce File => Export => PDF. Ve vyvolané nabídce zvolte nejvyšší 

kvalitu a potvrďte.  

 

 
 

Další stránku vytvoříte pomocí ikonky s listem a značkou + v horní liště. Postup 

opakujte dokud nevytisknete všechny stránky vystřihovánky. 

 

11. krok - Návod, návodový obrázek 

Zbývá napsat návod, aby modeláři věděli jak postupovat při lepení modelu. Návod se 

zpravidla doplňuje o návodový obrázek, ze kterého je zřejmé umístění jednotlivých 

dílů.  

Nejprve je dobré uvést pár slov úvodem, napsat něco o stavbě, kterou model 

představuje. 

Další částí jsou přípravné práce. Na ukázku uvedu text, který uvádím já ve své 

vystřihovánce: 

 

K lepení si připravte nůžky, nůžtičky, krabičku na díly, aby se vám neztratily 

v průběhu práce, pravítko, nůž a lepidlo. Doporučuji lepidlo Herkules - schne rychle, 

takže se při kompletaci nemusí dlouho čekat, přesto je chvíli po přilepení spoj ještě 

možné upravit.  

Během práce udržujte vše čisté, ruce zamazané od lepidla špiní díly modelu a kazí 

výsledný dojem. 

Při stavbě postupujte podle návodu a během stavby se orientujte podle návodové 

kresby. Prostor na dílu, který je třeba vystřihnout je označen úhlopříčným křížem. 

Hrany, které budete ohýbat, doporučuji naříznout lehce podle pravítka nožem. Každý 

díl si nejprve složte nasucho - lépe si uvědomíte, jestli jsou hrany ohnuté na správnou 

stranu. Pokud je vše v pořádku, chlopeň jemně potřete lepidlem a přilepte.  

Na chlopni je označení na jaký díl má být přilepena (1 značí, že chlopeň má být přile-

pena na díl 1). Je-li chlopeň lepena na „vlastní“ díl, je označena %. (Menší chlopně 

můžou být bez označení, proto platí pravidlo dvakrát měř, jednou řež.) 

 

Náleduje vlastní návod. Popište postup prací, upozorněte na obtížné části a podobně. 

Opět ukázka: 

 

Začněte střechou. Skompletujte díly 1 a 2 a slepte je k sobě. Střechu dokončete přile-

pením dílu 3.  



 

 

Následovat bude vyhlídková plošina. Skompletujte osm dílů oken 5 a vlepte do dílu 4. 

Teprve potom díl 4 uzavřete. Následovat bude mladší část rozhledny. Slepte římsu 6, 

do dílu 7 vlepte čtyři okna 8 a dvě okna 9.  Skompletovaný díl 7 přilepte k římse 6.       

K dílu 10 přilepte díl 11 a skompletované dveře 12. Slepením dílu 7 a 10 dokončete 

spojení věže. Díl 4 napojte na římsu 6. Ke střeše přilepte horní vyhlídkovou plošinu, 

tj. k dílu 3 přilepte díl 4.  

 

Dále pak můžete uvést závěrečné poznámky k celému modelu, případně vzkaz 

budoucím modelářům. 

 

Návod doplňte návodnou kresbou. Ve SketchUpu nastavte pohled na váš neotexturo-

vaný model, zvolte zobrazení dvoj- či tříúběžníkové perspektivy a nastavte Face style 

na Shaded. (Pokud tuto nabídku nemůžete najít: horní lišta záložka View => Toolbars 

=> Face style.) Z vyvolaného panelu zvolte Shaded. Exportujte pohled jako obrázek 

ve vámi zvoleném formátu a v libovolném obrázkovém editoru doplňte čísla dílů. 

Pokud váš pohled nepokrývá model dostatečně, poskytněte jich modelářům několik, 

z několika úhlů. U složitějších staveb je vhodné zařadit také detailní pohledy např. 

s označením drobných dílů.  

Pokud je váš model rozsáhlý, lze jej barevně rozlišit, čísla dílů částí modelu podbarvě-

te různými barvami a stejnými barvami rozlište tyto části i v návodovém obrázku. 



 

 

12. krok - Dokončení vystřihovánky, tisk 

Zbývá vytvořit úvodní stránku, vystřihovánku vytisknout a svázat do výsledného 

formátu. Na titulní stránce je zvykem uvádět název stavby, autora vystřihovánky, 

měřítko a obtížnost modelu. Obtížnost 1 patří těm nejjednodušším miniboxům 

(modýlky domečků a pod., v podstatě jen kvádry se střechou), obtížnost 5 patří 

komplexním a velice náročným modelům.  

Strany na kterých jsou díly tiskněte na matný papír vyšší gramáže (nejlepší je téměř 

nesehnatelný 100g, nebo dostupnější 120g)  samozřejmě jen z jedné strany (často       

je na rubu dílů uveden návod, nechápu proč je tento nesmysl stále populární).  

 

Tím je tento návod kompletní. Na závěr uvedu příklady typických řešení některých 

architektonických detailů.  



 

 

 

Válec jako tělo věže atp. 

Jednoduchý tvar. V návodu uveďte radu ať modeláři před sestavením dílu ohnou díl 

pomocí tažení přes hranu stolu. Trojúhelníkové chlopně, které se používají pro 

zakřivené plochy, se vždy přidávají na díl pláště, ne na podstavy. Kruh by po ohnutí 

chlopní vpadal neforemně, zatímco na plášti se chlopně tolik neprojeví. Pro rozvinutí 

pláště do roviny použijte opět plugin Unfold (pokud máte na plášti texturu), nebo 

vytvořte obdélník se stranou dopočítanou podle obvodu podstav. Nastavíte-li válci 

více segmentů, nebude nepřesnost (válec × n-stěn) vůbec znatelná. Podstavy tvoří 

samostatné díly. 

Kužel jako střecha věže atp. 

Pokny jsou prakticky stejné jako pro válec. Na chlopeň u vrcholu použijte menší úhel. 

 



 

 

 

Zakřivené roviny jako zdi barokních staveb atp. 

Pokyny jsou prakticky stejné jako pro válec. V návodu upozorněte na obtížný díl          

a poraďte vyzkoušení nasucho. Změny směru ohybu naznačte nepatrně na díl, nebo 

pokud to nenápadně nejde, v návodu poraďte modelářům propíchnout v oněch 

místech na krajích díl kružítkem a z rubové strany narýsovat linku tužkou. 

 
Polokoule jako kupole atp. 

Předně si musíme ujasnit, že polokouli z papíru vyrobit nelze. Musíme se tedy tomuto 

tvaru co nejvíce přiblížit za využití papíru. V ilustračním obrázku je zapnuto 

zobrazení skrytých čar (čárkovaně). 

 
Komín 

Chlopně na spodní straně dílu se ohýbají na opačnou stranu a celý díl se vlepí do 

otvoru v dílu střechy. Vrchní část komínu je tvořena pouze slepením překryvu dvou 

čtverečků o šířce komína, nepoužívá se zde chlopní. Na komín se zpravidla lepí ještě 

další díl, který je tvořený pouze dvěma čtverci, které se přehnou a přilepí k sobě. Tyto 

dva čtverce jsou o málo větší než průměr komína. 

 



 

 

 

Vikýř 

Nejprve zkompletujte oba díly, poté je vlepte do otvoru v díle střechy. 

 
 

 

Elektronická verze tohoto návodu je přístupná na stránkách předmětu Deskriptivní 

geometrie ve formátu PDF. K návodu je přiložena i vystřihovánka rozhledny 

Štepánka, kterou vám doporučuji projít a zejména si povšimnout některých řešení: 

Zábradlí na spodním ochozu (díly 13a a 13b), řešení vstupních dveří do mladší, 

cihlové části rozhledny a ozdobné římsy na kamenné čáti rozhledny (díly 19). 

 

Hodně zdaru při tvorbě vaší vlastní vystřihovánky!! 

 

 

 

 

 


